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SONAR 2016.08 Update 

 
The big news for this update is plug-in 
Browser improvements. We’ve been 
fielding a lot of suggestions on how to 
improve the Plug-In Manager, but then we 
thought how much cooler it would be if we 
incorporated those kinds of changes into 
the plug-in Browser itself. So now there are 
new ways to sort, easy options for friendly 
names, re-organization, and more—all 
without leaving the Browser. Because plug-

ins are such an important part of today’s productions, we’re sure you’ll appreciate the 
enhanced plug-in organization. 
 
This update also brings Phase 1 of Comping and Lane Management improvements, which are 
mostly about streamlining the user interface, reducing clutter, and making the process more 
user friendly. We’re not stopping here, though…stay tuned for more developments. 
 
In other news, you can now add an effect to multiple tracks via Quick Grouping. Also as you’ve 
probably noticed, it looks like we’ve created a monster with the Theme Editor—so we’re 
putting the spotlight on some of the creative themes the community is generating, as well 
Theme Editor language localization. Of course, there’s our usual relentless quest to stamp out 
bugs, and popular eZine features like Surfboard, the latest Top 10 Chart (frankly, we were 
shocked at what it told us), and more. So settle back, boot up, have fun, and…see you next 
month.  – The Cakewalk Team 
 
 

Plug-In Browser Enhancements: Now you can sort, move, create, copy, and 
organize plug-ins with much greater flexibility. Give plug-ins friendly names easily, 
mix VST2 and VST3 plug-ins along with DirectX, and much more…as well as still use 
the Plug-In Manager for custom layouts. 

 
Comping and Lane Enhancements (Phase 1): From having more freedom to set 
Lane height, to having new Takes stack on top of or below other Takes, to 
eliminating visual clutter left over from yesteryear’s operating systems, to 
smoother workflow, Phase 1 adds quite a few improvements to comping. 

 
User Interface Improvements: While working on the comping improvements, we 
saw some ways to carry over those improvements to the program as a whole. 
These enhancements make crossfades easier to see even when zoomed out, and 
uses the standard stretch cursor when stretching Clips and Takes. 
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SONAR Theme Editor Localization: We knew there were lots of requests for a way 

to edit themes, but we didn’t realize just how popular this feature would be. So the 

Theme Editor continues to evolve, and now version 1.1.0.22 follows whatever 

language is selected in the Windows OS.  

 
 Themes from the SONAR Community: The SONAR community never ceases to 
amaze us with the constant flow of great ideas and suggestions—it’s because of 
you that many of these features exist. And now, you’ve been creating some very 
cool—and downloadable—themes. We suspect more will be forthcoming… 

 
Quick Group Insert FX: Here’s another feature that many users have wanted: the 

ability to insert the same effect into multiple selected tracks, simultaneously. So, 

this update expands Quick Grouping to allow opening the same MIDI or Audio 

effect in multiple tracks at once.  

 
Fixes and Enhancements: Some long-standing bugs were terminated with extreme 
prejudice this month, including VST3 plug-ins not showing up properly in custom 
menus, MIDI clips splitting if you used nudge, Track Manager not remembering 
some settings when switching from Track to Console view, and more. 

 

Charting Now in SONAR | The Top 10 Audio Outputs: So which interface outputs 
log the most session time? If you were thinking some cool USB or FireWire 
interface would be #1, well, the answer is not what you might expect…as you’ll find 
out when you look over this month’s Top 10 chart. 

 
Anatomy of a SONAR Project | Creating a Chord Library: Sometimes you need to 
kick start the songwriting process, find the right chord for a chord progression, or 
crash through a creative roadblock. So, find out how to make a Chord Library—a 
collection of chords you can drag-and-drop from the Media Browser. 

 
Review | Universal Audio Apollo Twin USB Audio Interface: USB 2.0 not fast 
enough? Tired of waiting for Thunderbolt? USB 3.0 can deliver lower latency and 
better performance, but Universal Audio’s take on the audio interface folds in DSP-
based effects too. 

 
SurfBoard: Surfing the internet can be fun, but surfing the Cakewalk forums can be 
downright instructive because community members are constantly sharing tips and 
techniques. We’ve scoured the forums for the latest threads that can help you get 
the most out of SONAR, and compiled them here. 
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How to Download the SONAR 2016.08 Update 
 

Open the Cakewalk Command Center. If you don’t have the latest version 

(CakewalkCommandCenterSetup_1.1.6.2.exe), please download it from the Cakewalk 

Command Center home page.  

 

To download the SONAR 2016.08 core update, download from the core SONAR Artist, 

Professional, or Platinum category. Platinum members should also download the latest version 

of the Theme Editor, which is a separate program and appears under Connected Products. 

 

  

https://www.cakewalk.com/Command-Center
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Plug-in Browser Enhancements 
Artist, Professional, Platinum 
 
You could always create custom plug-in layouts in SONAR via the Plug-In Manager utility, but 
now you can sort/organize plug-ins, assign plug-ins to categories, and create new categories 
within the Browser itself. This organizational overhaul streamlines workflow in many ways. 
 

There are three options to sort plug-ins—by Category, 
Type, or Manufacturer—from the Browser’s PlugIns 
drop-down menu. 
 
Sort by Manufacturer sorts plug-ins alphabetically by 
manufacturer name. 
 
Sort by Type sorts plug-ins by their native format 
(VST3, VST2, and DirectX) and within each format 
folder, sorts alphabetically by manufacturer. 
 
Sort by Category, the default layout, organizes plug-
ins into category subfolders such as EQ, Dynamics, 
Reverb, and the like. If a plug-in has more than one 
category, it will be listed in each category subfolder. 
For example, a plug-in could be in both a “Reverb” and 
“Favorites” category. 

 
Furthermore, you can now: 
 

 Move plug-ins to any of the default categories 

 Copy plug-ins to any of the default categories 

 Create your own custom categories, without using the Plug-In Manager 

 Combine VST3, VST2, and DirectX plug-ins in the same category 

 Take advantage of automatic categorization for many popular VST2 plug-ins from 
companies like UAD, iZotope, SoundToys, and Native Instruments 

 Customize friendly plug-in names via the Browser 
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MOVE A PLUG-IN TO A CATEGORY 
 
1. Choose “Sort by Category” from the Browser’s 
PlugIns drop-down menu. 
2. If necessary, open the folder needed to reveal a 
plug-in. 
3. Right-click on the plug-in and choose the category 
from the Set Category’s drop-down menu. 
 
For example, TC’s Polytune tuner was originally 
assigned to the “Analyzer” category. You might 
think it’s more appropriate in the Guitar category, 
because that’s when you use it. The screen shot 
shows how you would move Polytune to the Guitar 
category after right-clicking on the Polytune plug-in. 

 
Note: Moving all plug-ins out of a Category removes the associated folder automatically. 
 
 
COPY A PLUG-IN TO A DIFFERENT CATEGORY 
 
You may want a plug-in in more than one category. For example, although the PX-64 drum 
processor is in the Channel Strip category, it’s also excellent with bass so you might like to have 

it in the Bass category as well…or 
copy it to a “Favorites” category. 
 
1. Choose “Sort by Category” from the 
Browser’s PlugIns drop-down menu. 
2. If necessary, open the folder 
needed to reveal a plug-in. 
3. Right-click on the plug-in and click 
on the + sign to the right of the 
current Category. This opens up a new 
field. 
4. Choose the category from the Set 
Category’s drop-down menu, then 
click OK. 
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CREATE A NEW CATEGORY 
 
1. Choose “Sort by Category” from 
the Browser’s PlugIns drop-down 
menu. 
2. If necessary, open the folder 
needed to reveal a plug-in. 
3. Right-click on the plug-in and click 
on the + sign to the right of the 
current Category. This opens up a 
new field. 
4. Click in the category field, type in a 
new name, and then click OK. 
 
 
 

 
SAVE THE DEFAULT CATEGORY SETUP 
 
From the Browser’s PlugIns drop-down menu, choose Manage Layouts. The Plug-In Manager 
will be populated with the current configuration. Enter a name for the layout file, and then click 
the Save button (floppy disk icon). 
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GIVE A PLUG-IN A “FRIENDLY NAME” 
 
1. Choose “Sort by Category” from 
the Browser’s PlugIns drop-down 
menu. 
2. If necessary, open the folder 
needed to reveal a plug-in. 
3. Right-click on the plug-in, click in 
the name field, and type in a new 
name.  
4. Click OK.  
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Comping and Lane Enhancements (Phase 1) 
Artist, Professional, Platinum 

 

This update provides several improvements to the editing tools, and visual feedback for 

comping. Also, some of the user interface “clutter” has been removed to streamline the visual 

look and overall workflow. 

 

 Automation and Take 

Lane heights can now 

be as short as tracks, 

with a maximum 

height up to double 

what it was 

previously. 

 Lanes with a 

highlighted name 

background are the 

“Active” Lane. Not 

only has cut and 

paste been improved, 

but there’s better 

visual feedback—a 

pasted clip or 

automation selection 

“lands” at the Now 

time in the Active 

Lane. 

 Automation Lanes 

have a name field 

where you can enter 

custom names up to 128 characters long. 

 Splits no longer go vertically across the entire clip, which improves visual feedback of 

promoted clips. Instead, there’s a small triangle at the bottom of Clips where the split 

points occur. 

 You can choose in Preferences > Project > Record whether new Takes are placed at the 

top of a stack of Takes (check “New Takes on Top”) or at the bottom (uncheck “New 

Takes on Top”). 
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 To adjust crossfade durations, hold down Ctrl, hover the mouse over a Take Lane split 

until the cursor turns into the Crossfade icon with up/down arrows, then click+drag 

vertically (up to increase crossfade time, down to decrease). 

 

 

 

 

 

 

 

 

 

 

 

 There’s a new cursor for Comping. 
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User Interface Improvements 
Artist, Professional, Platinum 

 

While working on the Comping and Take Lane management, we decided to clean up some 

aspects of the user interface in general. These apply whether you’re using comping, or working 

in the Track View with standard tracks. 

 

NEW TIME-STRETCHING PROTOCOL 

 

Previous versions used the same cursor to slip-edit and stretch, which could be confusing—

especially because there already was a dedicated stretching cursor (formerly, a yellow line 

added to the clip edge indicated that stretching was occurring). Now, the same stretch cursor 

appears for all stretching functions. 

 

 

 

 

 

 

 

 

To time-stretch a Clip or Take, you now need to hold both Ctrl+Shift instead of only Ctrl when 

click+dragging on a Clip or Take edge to stretch. 

 

BETTER CROSSFADING VISIBILITY 

 

Crossfading is an important part of comping, so now the automatic fades on clips are much 

easier to see, even when zoomed out relatively far. However this improvement also helps when 

looking at tracks, particularly when assembling and crossfading loop-based material. 
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SONAR Theme Editor Localization 
Platinum  

 

The Theme Editor continues to evolve, and now version 1.1.0.22 follows whatever language is 

selected in the Windows OS. Please note that localization does not necessarily follow SONAR’s 

selected language (Chinese, English, French, German, Italian, Japanese, or Spanish), nor does it 

follow the language preference specified in the Cakewalk Command Center. 

 

Okay…we’re ready for those cool international themes!  
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Themes from the SONAR Community 
Artist, Professional, Platinum  

 

Once the Theme Editor appeared, we expected that the community would start creating and 

exchanging themes—and there are plenty of choices. For descriptions and comments visit the 

SONAR Resources and Utilities thread in the Software forum. Here’s just one example of a new 

theme—a “hybrid” theme that combines elements of both Mercury and Tungsten. 

 

 
  

http://forum.cakewalk.com/Sonar-Resources-and-Utilities-m3392713.aspx
http://forum.cakewalk.com/Software-f83.aspx
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Quick Group Insert FX  
Artist, Professional, Platinum 
 

Ever wanted to insert the same effect simultaneously in multiple tracks? Now you can, thanks 

to this addition to Quick Grouping. Here’s how: 

 

1. Select the tracks where you want to insert the effect. 

2. Hold the Ctrl key. 

3. Right-click in the FX bin for any selected track, and then choose the effect. 

4. Release the mouse button and the Ctrl key. 

 

Done! If you make a 

mistake, hit Ctrl+Z to 

undo adding all the 

effects. 

 

Note that this works 

for MIDI as well as 

audio tracks. In the 

screen shot, drum 

sounds recorded in 

real time to individual 

tracks now have the 

Quantize MIDI plug-in 

inserted so they can all 

be quantized non-

destructively during 

playback.  
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Fixes and Enhancements 
 

Fixed SONAR issues where: 

 

 VST3 plugins weren't listed in Insert Effect > Audio Effects with custom layouts 

 Process Audio commands ran slowly on multiple split clips 

 Track View snap settings didn’t work with all tools 

 Nudging MIDI notes inside the inline PRV could cause clips to split and notes to 

disappear 

 SONAR could crash under some conditions when adding an envelope 

 Stop At Project End could cause unexpected playback behavior in new projects with 

loop points 

 Double-clicking on drum-mapped clips didn’t open them in the Piano Roll view when 

Click Sets Now was turned off 

 Ctrl+Alt+Scroll Wheel in the PRV Timeline would zoom in and out at non-linear and 

opposing rates 

 Mouse movement over the tracks pane could cause dropouts when using TH3 

 Track folders didn't open/close properly after initially switching screensets 

 Invoking the  Replace Synth function could cause SONAR to hang 

 Track View wouldn’t scroll when moving a clip with Shift held down, or copying a clip 

with Shift+Ctrl held down 

 The Track Manager “Keep Track / Console Visibility In Sync” function could fail 

 Drawing notes in Lanes could display temporarily in another Lane 

 Adjusting the background color of multiple clips could change the foreground color 

unexpectedly 

 

 

  



16 | P a g e  
 

Charting Now in SONAR:  

The Top 10 Audio Outputs  
 

 

You can’t run SONAR without an audio interface (well 

actually you can…but why would you?), and we 

thought it would be interesting to find out what the 

community uses. USB? FireWire? Sound cards? We 

asked Cakewalk Analytics to tell us, and here are the 

results. Note the rankings are based on how many 

sessions each of the following was used as the audio 

output—not the total number of interfaces, or 

popularity of particular units. 

 

#1: ASIO4ALL 

ASIO4ALL was used for far more sessions than any other output option. Maybe it’s because a 
lot of people are using laptops, or maybe it’s because they don’t have a proper interface, but 
suffice it to say no one expected that ASIO4ALL would hit #1. 
 
#2: Realtek High Definition Speakers 
Yes, this option is #2 and begs the same questions as above. Maybe this is a laptop world. 
 
#3: Focusrite USB 2.0 Audio Driver 
When it comes to actual audio interfaces, Focusrite rules with more “output share” than any 
other audio interface. But nipping on its heels, you’ll find....  
 
#4: Roland Octa-Series Interfaces  
These hardy perennials continue to be the interface of choice for quite a few SONARians. 
  
#5: RME Fireface USB  
Whether analog, SDPIF, or ADAT outputs, the FireFace is a workhorse—in fact Fireface fans are 
the most prolific users of the ADAT outputs. (However note that overall, the USB flavor 
predominates: Cakewalk Analytics confirm that FireWire is definitely in its twilight years, at 
least for SONAR users.(  
 
#6: MOTU 
MOTU’s line of interfaces holds a solid position in the middle of the pack, particularly in terms 
of audio outputs although there are quite a few people using S/PDIF outputs as well. 
 
#7: Native Instruments Komplete Audio 6 
As a relative newcomer to the audio interface world, Native Instruments has broken into the 
Top 10 with the Komplete Audio 6. 
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#8: PreSonus AudioBox 
Although this doesn’t have anywhere the number of ADAT outputs represented as the Fireface, 
it comes in second but also, a lot of folks use the analog and S/PDIF outputs. 
 
#9: TASCAM US-Series 
Like Cakewalk, TASCAM is a Gibson Brand—so we’re happy to see their interfaces breaking into 
the Top 10. 
 
#10: “Others” 
As you might expect, there are a zillion interfaces in use so rather than come up with a 
definitive #10, here are other interface outputs that get used a lot on sessions: Universal Audio 
Apollo, various E-Mu ASIO interfaces, Steinberg UR44, M-Audio Delta, VS-type Roland 
interfaces, PreSonus FireStudio, RME Hammerfall, and more. There are even some diehard 
Creamware SCOPE users in there, as well as a whole lot of interfaces we’ve never even heard of 
that were used on a few sessions.  
 
So what conclusions can we draw? USB is way ahead of FireWire, Focusrite is really popular, 
and the number of people using ASIO4ALL and Realtek sound chips is…surprising, to say the 
least. If you’re in that category and using a desktop machine, consider using an audio interface 
with dedicated ASIO drivers. Although ASIO4ALL is clever, it works by trying to fool programs 
into thinking they’re using ASIO and not the Windows sound drivers. Some users report no 
problems at all with ASIO4ALL, while others report that uninstalling it solved many vexing 
problems, and/or allowed true ASIO interfaces to work much more efficiently if both driver 
types were installed on the same machine. 
 
Would the number of “I have a problem with SONAR” posts in the forum go down dramatically 
if everyone stopped using ASIO4ALL? Unfortunately, Cakewalk Analytics can’t tell us that…but it 
wouldn’t surprise us. 
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Anatomy of a SONAR Project: Creating a Chord Library 
 

By Craig Anderton 

 

When I was learning guitar, I had books with diagrams of every chord type possible. Not only did it teach 

me chords, but whenever I hit a creative block, I’d experiment with playing different chords to get out of 

“chord progression ruts.” 

 

I wanted to have a similar creative tool for SONAR, but take it to the next level and integrate a “virtual 

chord library” into the songwriting process. The 

object was to have a folder in SONAR’s Media 

Browser with all possible chords, so I could simply 

click on chords to test out different progressions (to 

do this, in the Browser’s Media drop-down menu 

check “Auto-Preview,” then uncheck “Preview at 

Host Tempo” and “Loop Preview”). If I liked a 

particular progression, I could then drag the chords 

into Take Lanes and flesh out an arrangement. To 

make the Chord Library more flexible, I also created 

four instruments that map chords to keyboards 

(e.g., the middle octave is major chords, the octave 

below minor chords, etc.) so I could play chord 

progressions directly from a keyboard. 

 

The virtual Chord Library actually turned out to be 

far more useful than I had expected; three songs on 

my upcoming album were the direct result of using 

the Chord Library to come up with chord 

progressions I wouldn’t have thought of otherwise. 

Furthermore, whenever I demo the Chord Library 

at workshops, people want to know where they can 

get it. You can’t, so this article shows how to create 

your own.  

 

CREATING THE CHORDS 

 

As shown in the screen shot, the “development 

system” for the Chord Library was a SONAR project 

that sampled every guitar note up to A 440 from a 

Les Paul Gold Top from the Gibson Custom Shop, 

using a consistent picking technique to give a 

consistent sound (as well as normalizing to the 

same peak level). Then I could create any chord I 

wanted, in any voicing, by soloing individual notes and bouncing the chord notes to a file. These ended 
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up in folders for particular keys. However before bouncing, I’d spread the timing of the notes a bit, with 

higher strings hitting slightly later to emulate the sound of a quick strum. This made the chords sound 

much more realistic. 

 

While this may seem like overkill, during my first attempts I soon found out that just playing chords and 

recording them didn’t cut it. Different levels, picking, and tones were distractions; consistency turned 

out to be important. Furthermore, I wanted to be able to create unlimited chord voicings…you never 

know when you’re going to need a 13th add 9+7, right? This approach can create any voicing, any time. 

 

ORGANIZATION 

 

I wanted to start with 13 chord voicings: Major, minor, 

5, 6, 7, 9, 13, Maj7, Maj9, Min9, Sus4, Augmented, and 

Diminished. That meant creating 156 chords, which 

surprisingly, wasn’t as time-consuming as I anticipated 

because of being able to drag the bounced chords 

directly into the Browser. However, having all 156 

chords visible simultaneously in the Browser was a 

visual overload, so I made the major and minor chords 

available directly from the Chord Library folder (which I 

added to the Browser’s Content Location drop-down 

menu), and placed the less-used voicings in folders. 

That made it easy to craft a song’s basic chord 

progression, then use the “color” chords as 

substitutions. 

 

By the way if you don’t know how to add a custom 

content location to the Browser, it’s easy: Navigate in 

the Browser to the desired content folder, then click on 

the floppy disk icon. 

 

USING IT 

 

The main way I use this is by dragging chords in from the Browser to a Take Lane—not a Track. This is 

because the chords have a natural decay that’s probably longer than the length you’ll want for the 

chord, so when you bring in the next chord and overlap the end of the previous chord in a Take Lane, 

the “tail” of the previous chord will end where the new chord begins. If you did this in a Track, the 

overlap would either crossfade if Options > Auto-Crossfade was enabled, or the two overlapping sections 

would play simultaneously. 
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Another advantage of arranging chords linearly in a Take Lane is that when you reach the end of the 

progression and don’t know which chord should follow next, just click on chords in the Browser until you 

find one that fits. 

 

However, note that changing tempo after creating the progression isn’t advisable as there are individual 

chords. If you slow down, there will be gaps between chords and if you speed up, overlaps will play at 

the same time. Assuming the chord progression is as desired and you just want to change the tempo, 

there’s a simple solution: Bounce all the chords together to create a single Clip, and then either use the 

time stretch function, or convert the Clip to a Groove Clip to conform to the new tempo. 

 

THE INSTRUMENTS 

 

For more spontaneous 

experimentation, the Chord 

Library Instruments do the job. 

I created four instruments for 

Dimension Pro (which I’m going 

to re-do for Rapture 

Pro/Session) that use synth 

processing to change the basic 

guitar chord sounds. Pads cuts 

off the attack and gives a 

sustained sound, Synth 1 and 

Synth 2 are two different synth-

type sounds, while Standard is 

simply the sound of the chords. 

As alluded to earlier, the chords 

are mapped per-octave; on a four-octave keyboard there’s one octave of major chords, one of minor 

chords, one of 7th chords, and another with just tonic+5th (the “power chord” voicing). 
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AND FINALLY, A PLEASANT SURPRISE 

 

With one song I laid out the entire progression using the Chord Library, and fully intended to replace the 

chords with a “real” guitar part. However as the song developed, the Chord Library chords did what was 

needed. In fact, the consistent sound worked very well. So I created a “clean” track for the chorus with 

the Blue Tubes Analog Channel and a Sonitus Delay, a “dirty” track for the verse with the CA-X Hard Rock 

amp and a Sonitus Delay, and moved the Chord Library clips to the appropriate tracks. Although I did 

overdub a J-45 acoustic guitar at the end, the Chord Library parts did the heavy lifting—so I guess they 

do have more uses than just songwriting.  
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Review: Universal Audio Apollo Twin USB Audio Interface 
 

By Craig Anderton 

 

When Apple and Intel introduced Thunderbolt, it seemed like audio latency issues would be 

over. Everything would be lickety-split fast, our older stuff would still run fine with the help of 

some adapters, and we’d all live happily ever after in a world where you heard a note when you 

played a note. 

 

Well, Thunderbolt hasn’t gotten traction with Windows. I won’t repeat the conspiracy theories 

(which are probably true!) from various developers, but suffice it to say even if your Windows 

computer does have Thunderbolt, what you want to run on it may not have drivers. Of course, 

this is a great source of merriment for the Mac fans (“Ha ha! Windows can’t do Thunderbolt! 

Suckers!!”) but they don’t know the dirty little secret: 

 

Windows users can already attain Thunderbolt speeds, and have for years. 

 

This is because several Windows audio interfaces are based around PCI cards. Thunderbolt 

essentially takes the PCI bus and brings it outside the computer, so if you have something like a 

Lynx or MOTU PCI interface card, you already have the potential to run at Thunderbolt speeds. 

 

Unfortunately, though, that’s not always an ideal situation. Laptops rarely include card slots any 

more, and computers have ever-fewer PCI slots. Also, you can’t outfit a PCI card with the kind 

of I/O an audio interface needs, which leads to breakout cables and the like. Fortunately, we 

have an alternative that’s a lot more convenient: USB 3.0. 

 

We already covered 

TASCAM’s US-20x20 

interface for USB 3.0, and I 

was very impressed by its 

performance for a variety 

of reason, not just the 

extra speed. Although 

more manufacturers are 

getting into USB 3.0, now 

we have a different twist 

on the USB 3.0 theme, 

courtesy of Universal 

Audio. 
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I’ve been aware of, and using, Universal Audio’s plug-ins since the days of their first PCI card. 

Simply stated, this is a high-end company that does great work: their analog plug-ins truly 

sound analog. Furthermore, back in the days when native systems could barely run a reverb 

without choking, UA put their plug-ins on hardware DSP so the DSP did the heavy lifting, not 

your CPU. What’s more, you could “red-line” the DSP because it wouldn’t get asked by your 

computer to do anything else. UA has also had great success with their Apollo interfaces, which 

feature refined sound quality and low latency.  

 

However, they realized that with Thunderbolt dragging its feet with Windows, if they wanted to 

make something relevant for Windows they needed a different solution—which brings us to 

Apollo Twin USB, a USB 3.0 interface  dedicated exclusively to Windows-based systems. 

 

YES, IT’S AN INTERFACE, BUT… 

 

Technically speaking, Apollo Twin USB is a 2 x 6 USB 3.0 interface. And technically speaking, a 

Ferrari is a car but you wouldn’t put in the same category as a Ford Focus (then again, nor 

would you put it in the same price range). 

 

Apollo Twin USB might give you sticker shock (it “streets” for around $900) until you look 

deeper. First, the 2 x 6 designation isn’t the whole story, because there are also 8 channels of 

ADAT optical input—ideal for adding, for example, eight more mic pres (although note this 

reduces to 4 channels at 96 kHz, and 2 channels at 192 kHz). There’s also onboard DSP for 

running UA’s Powered Plug-Ins, which offer several advantages we’ll get to shortly.  

 

 
 

The two mic preamps are excellent, but I need to address those people who say they feel UA’s 

preamps lack “color” or “personality”—I feel that’s missing the point, because UA makes plug-

ins like channel strip emulations that model very subtle nuances of different pieces of gear. The 

preamps have to be neutral to avoid hiding those nuances. Think of it this way: If you’re going 
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to paint an oil painting, you want to start with a stark white canvas, otherwise the colors won’t 

translate correctly. 

 

THE “SECRET SAUCE” 

 

What makes Apollo Twin USB way different from standard interfaces is that the DSP-based 

processing allows recording or monitoring through effects with, for all practical purposes, zero 

latency. But it’s actually more versatile than you might think, because UA’s plug-ins can work in 

SONAR’s effects rack like standard plug-ins, as well as in real time using Apollo’s DSP; and 

there’s a 

sophisticated 

Console applet that 

allows for various 

routing options.  

 

So consider this 

scenario…you’re a 

guitarist. You can 

place a DSP-based 

amp sim at the 

input, hear it with 

zero latency, and 

record the processed 

sound. Ah, but you 

say you need to record a dry track in case you change your mind. Okay, then monitor through 

the amp sim, and record dry. Then when it’s time to mix down, insert the amp sim as you would 

any other plug-in. Throughout this entire process, you’ve been playing guitar and hearing the 

amp sim sound with no latency. 

 

Another “secret sauce” is what UA calls “Unison Mode.” While that might conjure up images of 

16 sawtooth waveforms playing simultaneously to produce the Bass Sound of the Gods, it 

actually has nothing to do with synthesis. Rather, the Apollo Twin USB preamps are digitally 

controlled, and can mimic the characteristics of hardware analog inputs (not through digital 

modeling, but by altering the analog circuitry). An obvious example is changing the input 

impedance to match a particular guitar amp. 

 

The interface comes with a reasonable selection of UA’s Powered Plug-Ins: UA 610-B Tube 

Preamp and EQ, the Rat-like Raw distortion plug-in, Softube Amp Room Half-Stack, Softube 

Bass Amp Room, 1176SE and 1176LN limiters, Pultec equalizer, LA-2A Leveling Amplifier, 

Channel Strip, Delay/Modulation processor, Reflection Engine, and RealVerb Pro reverb. Of 
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course UA would like you to augment that collection with their many optional-at-extra-cost 

plug-ins, but the included plug-ins meet UA’s usual level of quality.  

 

AND ALSO… 

 

The industrial design is classy, and the unit is portable. However, USB bus power alone is not 

sufficient; you need to use the included AC adapter. This isn’t surprising given that power has to 

feed the DSP as well as the preamps, display, headphone amp, etc. 

 

The bottom line is you’re paying for a USB 3.0 audio interface, but you’re also paying for plug-

ins that sound very much like—if not identical to—the gear being modeled, and can run with 

zero latency (well there is the latency involved in analog-to-digital conversion and back to 

analog, but that’s such a small part of the picture we can ignore it).  

 

There’s more that deserves coverage, like the Console application and some of the other bells 

and whistles, but I mostly wanted to give the big picture in this review. For a detailed, in-depth 

look at the Apollo Twin USB, I’ve been doing a Pro Review over on Harmony Central (where you 

can also ask questions or make comments if you’re so inclined). The review is still evolving and 

is about to segue into a new direction on how to assemble a Windows-based recording 

system—you’ll never guess which DAW I’ll be using—but there’s a lot more detail, as well as 

plenty of screen shots and some audio/video examples for those who want to know more. 

 

  

http://www.harmonycentral.com/forum/forum/Forums_General/team-hc%E2%80%99s-interactive-pro-reviews/31722826-%E2%80%8Bapollo-twin-usb-3-0-creating-a-windows-music-production-system
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Surfboard 
 

Surfing the boards in the SONAR forum can 
uncover a wealth of great tips, like these… 
 
High Pass, Low CPU 
When mixing, a lot of engineers like to insert a high 
pass filter on various channels to reduce low 
frequency “mud.” But which high pass filter gives 
the most effective performance for the least 
amount of CPU power? This thread offers a bunch 
of suggestions. 
 
Selection Time View and Splitting by Selection 
Curious about a clip’s length? Need to do more 
advanced splitting than just using the Scissors tool 

or typing “S” at the Now Time? There are some great power user tips here that you’ll likely use 
a lot in the future. 
 
Recorded Clips Randomly Disappear when Recording Stops 
This problem has bedeviled users for quite some time, but there’s a simple fix—and this thread 
reads like a detective novel as the SONAR community analyzes the clues, and solves the 
mystery. 
 
Help with Graphics Tablet Control of SONAR 
Yes, you can control SONAR with a graphics tablet…but you’ll have a smoother time getting 
your tablet to work with SONAR if you read this thread first. 
 
Friday’s Tip of the Week 
This thread has over 100 tips to help you get the most out of SONAR, and is periodically 
“compacted” to include reader comments in the tips themselves. There’s also an index in the 
first post, with a description for each tip, to help you find what you want more easily. Some tips 
also have audio and video examples. 
  

http://forum.cakewalk.com/High-Pass-Low-CPU-m3465110.aspx
http://forum.cakewalk.com/High-Pass-Low-CPU-m3465110.aspx
http://forum.cakewalk.com/Selection-time-view-and-splitting-by-selection-m3464710.aspx
http://forum.cakewalk.com/Selection-time-view-and-splitting-by-selection-m3464710.aspx
http://forum.cakewalk.com/Solved-Recorded-clips-randomly-disappear-when-recording-stops-m2764221.aspx#2764221
http://forum.cakewalk.com/Help-with-graphics-tablet-control-of-Sonar-m3461974.aspx
http://forum.cakewalk.com/Help-with-graphics-tablet-control-of-Sonar-m3461974.aspx
http://forum.cakewalk.com/FindPost/3074655
http://forum.cakewalk.com/FindPost/3074655
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